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A set of plugin objects that allow dynamic changes of a shape
extruded along a path. Shapes can be defined as:

Geometric shapes  eg rectangle, circle, arc
Section shapes  eg wide flange
User defined shapes via a 2D symbol

Display is via class texture or
specific texture listed in the Object Info palette.
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If interested, you can download the software from:
http://www.whwsolution.co.uk/vectorworks-extrude-path-tools

For any problems contact via email:  info@whwsolution.co.uk

Initially, the software will be time limited as a testing period. 

Also, use the software at your own risk and there will be no liability for any data loss 
from use of the software.
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Extrude Path 3D plugin creates a nurbs curve path
working in 3D only. Edit the path via Reshape  tool
or double clicking on the path

Parameters will be explained later.

Extrude Path 3D
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Extrude Path Planar plugin creates a polyline path
working in planar 3D and works best in a 3D view
using an "Automatic" plane via "\" key.

Edit the path via Reshape  tool or double clicking
on the path.

Parameters will be explained later.

Extrude Path Planar
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Extrude Linear plugin creates a single straight or
curved 3D extrude working in planar 3D and works
best in a 3D view using an "Automatic" plane via "\"
key.

Edit the path by dragging the end points of the linear
plugin. Curves are created by inputting a non zero
"Bulge" which is a perpendicular distance from the
plugin path to the arc mid point.

Parameters will be explained later.

Extrude Linear
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Extrude Multi Shape plugin is linear based which can
have different shapes for the start and ends for the
resulting extrusion as well as defining end plates.
In a 3D view for best results use an "Automatic" plane
via "\" key.

Edit the path by dragging the end points of the linear
plugin.

Parameters will be explained later.

Extrude Multi Shape
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Extrude Point plugin creates a 3D extrude working
in planar 3D and works best in a 3D view using an
"Automatic" plane via "\" key.

Edit the shape base and extrude heights via the
Object Info palette.

Parameters will be explained later.

Extrude Point
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Extrude Spacing Planar plugin duplicates an extruded
shape along a planar path and works best in a 3D
view using an "Automatic" plane via "\" key.

Edit the path via Reshape  tool or double clicking
on the path.

Parameters will be explained later.

Extrude Spacing Planar
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Extrude Panel Planar plugin creates extruded panel
geometry using the planar path as the outer edge and
works best in a 3D view using an "Automatic" plane
via "\" key.

Edit the path via Reshape  tool or double clicking
on the path.

Parameters will be explained later.

Extrude Panel Planar
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Extrude Cut Planar plugin creates multiple extrusions  
using the planar path as the outer edge and works best
in a 3D view using an "Automatic" plane via "\" key.

Edit the path via Reshape  tool or double clicking
on the path. 

Parameters will be explained later.

Extrude Cut Planar
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All Extrude tools have an Object Info Palette button"Edit Shape"
which allows the user to change the associated shape. A shape
pulldown menu can also be used to change shape.

There are three types of shape:

Standard geometric shapes
Plugins        section shapes (as Vectorworks Detailing shapes)
Symbols shapes defined in a symbol

Note:
When in Rotated Plan mode, clicking "Edit Shape" button will
reset view to Top view on exit.

Edit Shape Standard
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All Extrude tools have an Object Info Palette button"Edit Shape"
which allows the user to change the associated shape.

The second option is "Plugins"

The section shapes match those in Vectorworks "Detailing"
such as Angle, Channel and I-Beam including series types
such as metric,BSI and DIN.

Custom section shapes can also be defined in the
current units. Any section shapes that have filleted corners
can have those corners made sharp to save on 3D geometry.

Note:
Some obscure "Detailing" options are not available.
Also, when in Rotated Plan mode, clicking "Edit Shape"
button will reset view to Top view on exit.

Edit Shape Plugins
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All Extrude tools have an Object Info Palette button"Edit
Shape" which allows the user to change the associated
shape.

The third option is "Symbols"

Symbols can be used to define a multiple shape setup which
must be stored in a symbol folder "Shape Symbols".

Each symbol must have at least one entity stored in the
2D part of the symbol (ie in the Screen plane). Note, Layer
Plane objects are invalid.

Extrudes use the class texture "Other" definition of the
drawn plugin object for display. Alternatively, a specific
texture can be assigned via Object Info Palette>Render.

If "Use shape classes" is selected then the class texture of
the individual shapes are used instead.

Editing the base symbol does not dynamically change any
associated Extrude plugins which must be regenerated via
editing a parameter for example.

To apply scaling to the
selected shape symbol,
click the "Custom" button

Click the "Custom" tab and
edit X/Y scale factors.

Edit Shape Symbols
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All Extrude tools have an Object Info Palette button"Edit
Shape" which allows the user to change the associated
shape.

The fourth option is "Custom"

A Shape symbol can be set as the current shape symbol, see
previous page. The current custom shape symbol is listed as
the "From Symbol".

Scale factors can be set for both horizontal(X) and vertical(Y)
directions. There is a minimum scale factor or 0.001

Once scaling has been applied, it is possible to create a new
shape symbol based on the current scaled custom shape
symbol implemented via the "Convert" button.

To set scaling to the selected
shape symbol, click the
"Apply" button

To convert the scaled shape
symbol to a new symbol, click
the "Convert" button

Edit Shape Scaled Symbols
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Any shape symbol that contains any open polygons or polylines can have the 
extrusion thickness set via a Data Record “Poly Thickness” with the value always set 
in mm. The record will be automatically attached to an open poly when a specific 
shape symbol is selected in any extrude tool. Any poly fill is also disabled ie no fill. 

Note
Invisible edges other than the last open edge are currently ignored.

Offsets are to one side and positive to the left of the open poly direction. To flip to the 
other side, reverse the direction of the poly.

The minimum extrusion thickness is set at 2mm

Edit Open Poly Shapes
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All Extrude tools have an Object Info Palette button"Edit Shape" which allows the user to
change the associated shape.

A shape definitions orientation and position can be changed in relation to the underlying
path.

The pivot point of a shape is in relation to the bounding box of the shape and can be set
by bottom,centre,left and right locations. In addition, an offset and rotation can be
applied with X highlighted in red and Y in green.

The shape can also be flipped in horizontal and vertical axes about the shape centroid.

All of the orientation dialog parameters are duplicated in the object info palette to aid
quick editing.

Shape Orientation
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Textures for Extrude Path objects can be set via the “Render” tab in the Object Info
Palette. Texture references can be specific textures from the resource list pulldown
or via the texture definitions of the class associated with the object.

Symbol shapes also have the option set Textures via the classes used for the
contained objects.

Extrude Textures
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Object Fill and Pen attributes for a selected Extrude Path object can be changed via
the “Attributes” palette.

Fill must be set to "Solid" for textures to display otherwise the objects will be
displayed in wireframe.

To make attributes active, set the Texture option in the “Render” tab to “None”

Extrude Attributes
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Extrude Path Planar, Extrude Linear and Extrude Path 3D have options to:

- Reverse the direction of the underlying path
- Apply offsets from the ends of an open path
- Split path into separate segments
- Show/Hide the path.

which affect how the shape is drawn. End offsets can be either positive (shortened) or
negative (extended). If not "Show Path" then standard boolean operations and push pull
actions can be performed on the underlying 3D geometry. "Reverse Path" reverses the
shape settings and X offset.

"Status" displays an error message if the shape cannot be successfully swept along the
path. Generally paths should not intersect but can cross if  "Split at all end vertices" is
selected.

Start Offset

End Offset

Show Path

Split at vertices

Extrude Path Options



Vectorworks Extrude Tools 2024

copyright Bill Wood    email: info@whwsolution.co.uk       web: www.whwsolution.co.uk 20Top Index

Extrude Path Planar, Extrude Path 3D, Extrude Panel
Planar and Extrude Cut Planar have the option to change 
the path via the Reshape tool or double clicking on the 
geometry.

Planar honours the visibility of each segment,otherwise
all standard Reshape actions can be performed on the 
path.

Extrude Path Reshape
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All Extrude plugins can have the default preferences set prior to drawing a new object by
clicking the Preferences tool icon marked by the spanner and pencil.

Generally this will show the Shape definition dialog which also has a Set button which
displays a further dialog to specify any non shape related settings.

Extrude Set Preferences
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All Extrude plugins have a Preferences button in the Object Info palette which when
pressed displays a dialog confirmation for storing the current plugin object's settings as
the default settings for the tool preferences which will be used for any newly created
objects.

Extrude Store Preferences
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All Extrude plugins have a Part Data button in the Object Info palette which when
pressed displays a dialog giving the quantities of count, length, surface area and volume, all 
in the current units settings.

Extrude Part Data
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Extrude Linear has options to:

- Reverse the direction of the underlying path.
- Apply offsets from the ends of an open path.
- Draw an arc or circle path defined by a bulge between the line ends.
- Show/Hide the path.
- Draw mitres at ends from top, side or both

which affect how the shape is drawn. Positive offsets shorten the ends.
If not "Show Path" then standard boolean operations and push pull actions can be
performed on the underlying 3D geometry.

"Status" displays an error message if the shape cannot be successfully swept along the
path.

Set as circle draws a circle path with
diameter defined by the path length

Extrude Linear Options
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Extrude Linear has options to draw mitres at ends.

Mitre examples

+30.00°

-30.00°

Start

Top or Side

+30.00°

-30.00°

Start

Top or Side Centred

Both Centred -30

Both Centred 60

Top Centred 30
Side 30

Both 30

If the shape angle is not zero then the
"Mitres follow Shape Angle" option will align
the end mitres with the shape angle.

Extrude Linear Mitres
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Extrude Multi Shape has options to add end plates to the extrusion.

The “Maintain Shape” option takes account of the shape 
X/Y offsets and aligns the shapes accordingly.

Note:
Custom shapes can be used to maintain thicknesses 
while changing overall sizes.

Plate options

Width

D
ep

th

Width

D
ep

th

O
ffs

et

Edge Offset

O
ffs

et

Edge Offset

Rectangular Circular Fit Rectangular Fit Circular

Plates are extended by a thickness beyond the
extents of the extrusion.

To add plates within the extents then set Start/End
offsets as the Start/End plate thicknesses.

Extrude Multi Shape Plates
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Extrude Spacing Planar has the
following options:

Extrude Spacing Options

Align offset along length set
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Extrude Spacing Planar has the
following options:

If “Align offset along extrusion length” is unset,
the extrude offset will be perpendicular to the path 
otherwise the offset is inline with the extrusion.

Extrude Offset

Extrude Spacing Options

Align offset along length set
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Extrude Panel Planar has the following options:

Flat Pyramidal Curved Cushion

Solid format

Pyramidal with hole cut in
panel path outline

Edit path via
Reshape Tool

Flip sides

Extrude Panel Options
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Flat panels have two options,
Single Thickness and Panel Style

A set of default panel styles are
created in a folder “Panel Styles”.

Any Vectorworks Wall Style can be placed in the folder “Panel Styles” which will be 
displayed in the “Select Style” popup list.

Extrude Panel Options
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Extrude Panel Planar has the
following settings:

Offsets and Bezel Angle can have
negative values

Note:
Panel display is driven by Class texture, 
texture or fill/pen attribute as any Extrude 
Path object.

Panel Styles use component Class texture

Extrude Panel Options



If “Use Gasket Class Texture” option is 
unset than class fill/pen attributes are used.
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Extrude Panel Planar gaskets have the following settings:

Note:
Extension shown (300mm) consists of Gasket Extension plus Thickness.

The “Gasket Tight Fit” option ignores the gasket wrap around where the 
gasket height matches the panel thickness.

Extrude Panel Options
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Bezel Angle 30

30

Core set

Core set

Extrude Panel Styles are defined as a Wall Style accessed via Resource Browser

The setting of a Core component defines how
bezel angles are applied and can be stepped

Changes to a Panel Style are not
automatically applied to a Panel.

To update Panels, use menu command

    Tools>Utilities>Reset All Plug-Ins

-30

30

-30

Core set

Core set

Stepped

Stepped

Extrude Panel Options

Panel Composite 2

Panel Composite 1
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Extrude Cut Planar Options
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Extrude Cut Planar Options

Setout from Start

Setout from Middle

Setout from End

Bezel angle slices the extrusions defined by 
defined angle
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Data Report Format

A template file is included in the release which contains two worksheets for reporting on 
extrude path objects.

A database formula is setup to report on the objects and in some instances the fields use 
worksheet python scripts referenced by “=RUNSCRIPT” to extract the relevant data.  

The worksheet scripts are stored in the Extrude tools plugins folder with an example 
shown below.
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Extrude Part Data Report

The Extrude Part Data worksheet has the following format.

Multi shape symbol

Extrude Spacing

Shape size shown in current units

Part name taken from object’s name

Part number incremented for each extruded shape
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Extrude Panel Data Report

The Extrude Panel Data worksheet has the following format.

Shape size shown in current units

Other Panel Definitions
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Edit or Build Extrude PIO's menu
command allows conversion of
planar 2D/3D shapes or bulk editing
of existing Extrude path plugins.

Valid shapes include line, rectangle,
circle, oval, arc, 2D polygon, polyline,
nurbs curve and 3D polygon.

2D/3D loci are also allowed.

All invalid objects are deselected with a warning message "Invalid objects deselected"

A right click menu is available to invoke editing.

Edit or Build Extrude PIO's
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Conversion to Extrude Path plugin objects is allowed for:
-  All 2D shapes to Extrude Planar, Linear, Spacing or Panel pio's
-  2D/3D loci  to Extrude Point pio's
-  3D polygons/solid objects to Extrude Planar pio's
-  3D nurbs curves  to Extrude path 3D pio's

The number of valid selected objects is shown in brackets.

All existing Extrude path plugin objects can also be updated.

For conversion to new objects, options are available for Extrude Path Planar, Spacing
and Panel pio creation.

Other options allow deletion of selected reference objects and use active document class
when new Extrude Path plugins are created as well as setting the path display.

Edit or Build Extrude PIO's
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The Edit button displays the standard
shape editing dialog - see "Edit Shape"
details earlier.

“Synchronize shapes” uses a common 
shape edit over all extrude type plugins

“Use Class of source object for any new 
object” uses class settings of any source 
object for newly created extrude type 
plugins

“Apply shape edit only” ignores any 
changes to the path,spacing or point 
parameters for existing selected extrude 
type plugins

“Update existing display settings only” 
applies new display settings only

Edit or Build Extrude PIO's
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Spacing Layout

Spacing Rotation

Path

Point

Keep existing options are only active
when Extrude path plugins are selected.

Dialog controls relate to respective
Extrude path plugins

Edit or Build Extrude PIO's
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Dialog controls relate to Extrude Panel Planar plugin.
Options are greyed when not applicable to current Shape,
Type, Style or With gaskets

See earlier for description of Extrude Panel Planar plugin
options

Edit or Build Extrude PIO's
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Last selected Panel plugin Panel plugin current preferences

Edit or Build Extrude PIO's

Settings in the Edit or Build Extrude PIO’s dialog can be set from either the last selected 
plugin type or the current default preferences for an extrude type plugin.
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Conversion to Symbols is allowed for:
-  All 2D shapes, 2D/3D loci and symbols
-  3D face(s), nurbs curves/surfaces or solid objects

The number of valid selected objects is shown in brackets.
Symbol(s) must already exist in the current file.

Symbol placement can be setout along edges, at 2D/3D vertices or at the centre of faces
and be displaced by an offset or additionally rotated.

Edge setout can be from path start, end, from centre or equally spaced. Mitre at vertices
will take  account of the angle of the incoming and outgoing edges connected to a vertex.

Convert to Symbols
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Conversion from Faces is allowed for:
-  All 2D shapes
-  3D face(s), nurbs curves/surfaces or solid objects

The number of valid selected objects is shown in brackets.

Create lines/curves option converts valid object edges
to individual lines/curves and can take account of
linked/grouped 3D faces.

Create loci option converts valid objects to
individual 2D loci and can take account of
linked/grouped 3D faces.

Loci placement can be setout along edges, at 2D/3D vertices or at the centre of faces
and be displaced by an offset or additionally rotated.

Edge setout can be from path start, end, from centre or equally spaced.

Convert from Faces
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To install Extrude Path plugins, select menu
command "Plugin Manager..." from banner
menu option "Tools".

Activate "Third Party Plug-Ins" tab, click
"Install" button and select downloaded zip file
"Extrude Tools install <release>" and open.

Open "Extrude tools documentation"  PDF file and browse content for a description
how tools work.

Unzip "Extrude tools content <release>" to a preferred location to access
documentation and examples on how to use tools including marionette examples.

Tool Installation
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Select the Extrude Path Tools workspace to setup environment. See later to edit user
defined workspace.

3D Modelling tool palette

Object Context menu command

Convert menu command

Workspace Setup
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To add Extrude Path Tools to an existing workspace, select the required workspace and
"Edit Workspace"

Drag tool into the required palette

Drag command into the required menu.

Edit User Workspace
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By default the Extrude tools run in
demonstration mode with an expiry
date.

To license the tools, email the
following:

Vectoworks serial code
Name
Organisation

for example

Y5GUD5
Bill Wood
W H Wood Solution

Only last 6 characters of your
Vectorworks serial code is needed
- see Help>About Vectorworks dialog.

Contact details as below.

On payment for the tools, a text file
will be returned which can be selected
when the "License..." button is clicked.

This will activate the tools as shown
right.

Tool Licensing

Licensed version

Demonstration version
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The release zip file "Extrude Tools install" creates the following:

Folder: Plug-Ins/Extrude tools

Files:
Edit or Build Extrude PIOs....vsm
Convert to Symbols....vsm
Convert from Faces....vsm  in folder convertfaces
Extrude Linear.vso
Extrude Multi Shape.vso
Extrude Point.vso
Extrude Panel Planar.vso
Extrude Path 3D.vso
Extrude Path Planar.vso
Extrude Spacing Planar.vso
Extrude Cut Planar.vso
Set 3D Polys Planar.…vsm

Folder: Workspaces

File:
Architect EP Tools.vww

Note:
Library files can be opened directly from
the Resource Manager (Right click menu)

On Windows systems the Vectorworks User path is:
C:\Users\<user>\AppData\Roaming\Nemetschek\VectorWorks\2020\

On Macintosh systems, the Vectorworks User path is:
Library/Application Support/Vectorworks/2020/

The release zip file "Extrude Tools content" once unzipped to a user defined folder
creates the following:

Files:
Extrude tools documentation.pdf

Folder: Examples

Files:
Extrude tools examples 2020.vwx
EAP report templates.vwx

Note: VWX files may need to be converted to the current Vectorworks version.

Tool Setup
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